An Introduction to Adobe Captivate 5

Carmelina Arena
DER Projector Coordinator, Sydney Region
November 2011
# Table of Contents

Introducing Captivate 5  
What is Captivate?  
Planning Your Projects  
Different Modes in Adobe Captivate  
  1. Demonstration mode  
  2. Training Simulation mode  
  3. Assessment Simulation mode  
  4. Multimode recording  
Recording Size  
Automatic Recording  
Full Motion Recording (FMR)  
File Export Types  
Creating New Projects Options  
Slide Types  
Captivate Objects  
The Captivate Window  
Recording a Software Simulation  
Using Audio in Adobe Captivate  
  Using the Text-to-Speech Converter  
Recording Audio  
  Importing Audio onto a slide  
Using the Audio menu item  
  Importing audio as background music  
Adding a Title Slide  
Inserting Animated Text  
Inserting an Image Slide  
Insert an image  
Creating interactive quizzes  
  Setting Quiz Preferences  
  Multiple Choice Questions  
  Hot Spots  
  True or False Quizzes  
  Fill in the blank  
Matching  
Sequence
Sequence quizzes are a great way to build in a numeracy aspect to a Captivate quiz.

Rating scale (Likert) ................................................................. 35

Using the Question Pool Option .............................................. 36

Importing quiz questions from a question pool ................................ 37

Inserting Rollover Captions ................................................. 38

Inserting a Rollover Image .................................................. 39

Adding Buttons to slides .................................................. 40

Inserting a Text Entry Box .................................................. 41

Inserting a Rollover Slidelet .................................................. 42

Using Advanced Actions .................................................. 43

Using Variables .................................................................. 46

Publishing a project .......................................................... 49

Publishing SCORM compliant projects .................................. 50
Introducing Captivate 5

What is Captivate?
Adobe Captivate 5 software is an eLearning authoring tool that lets you create:

- software demonstrations
- interactive simulations
- quizzes, without programming

Planning Your Projects
Before you start to make a project in Adobe Captivate you must plan the detail. Ask yourself some questions:

- Who is my audience?
- Have I got all the assets together, like music, or video?
- Have I made a script/ storyboard?
- Do I want my project to be a demonstration or interactive?

When Planning projects, keep in mind that most useful projects contain the following basic elements:

- Title slide
- Credits and copyright
- Narration
- Images and animations
- Interactivity

Different Modes in Adobe Captivate

1. Demonstration mode

Use the demonstration mode when you want to demonstrate a procedure or feature, e.g. demonstrating how to insert clip art into a document. The movie produced in this mode however, does not provide any scope for user interaction. The user can only passively view actions that were performed when the project was recorded. When recording a movie in the demonstration mode, Adobe Captivate does the following:

- Adds text captions. For example, if the user clicks File in the menu bar, a text caption with the text, “Select the File menu” is created automatically.
- Adds highlight boxes to highlight those areas where the mouse is clicked.
- Adds text that is typed manually during the recording.
2. **Training Simulation mode**

Use the training mode when you want the user *to try the procedure* during the movie. The movie moves to the next slide only after the user has performed the previous action correctly. When recording slides in training mode, Adobe Captivate does the following:

- Adds click boxes at places where the user must click the mouse.
- Adds text entry boxes for user input. The failure and hint captions are added to each text entry box.

3. **Assessment Simulation mode**

Use the assessment mode when you want to test how well the user has understood a procedure. You can set a score for every correct click. You can also set the number of times the user can attempt a procedure. When the user fails to click the right option in the number of attempts provided, the movie moves to the next step. The user does not get any score for the failed attempt. When recording slides in assessment mode, Adobe Captivate does the following:

- Adds click boxes at places where the user must click the mouse.
- Adds text entry boxes for user input. The failure caption is added to each text entry box.

4. **Multimode recording**

When you record an Adobe Captivate project, you can choose to record in more than one mode. Multimode recording helps you save time when working on projects that require outputs in more than one auto recording mode.

**Note:**

When recording using multiple modes, Captivate will create a new file for each recording type. They will be shown in the workspace window as **different tabs**. The name of the file will show the type of recording it is e.g. demo, training etc.

**Recording Size**

Captivate comes with several pre-set window recording sizes. The 640 x 480 will play well over the web. It is best to maintain the pre-set size of 640 x 480 and resize the software window to that size. Otherwise, choose application for the whole application window to be used in the recording.

**Automatic Recording**

When you record using **automatic recording**, Adobe Captivate captures screenshots automatically and places them on separate slides. Mouse, keyboard, or system events are the common triggers for capturing screenshots. Automatic recording is the most commonly used recording method in Adobe Captivate. The recorded slides are inserted into a Captivate project.

Additional screenshots of the window can be inserted during automatic recording by pressing the **Print Screen** key.
Full Motion Recording (FMR)

During full motion recording (FMR), the entire set of events is captured in real time as a video. Use FMR for movies that demonstrate complex procedures, such as drawing or reshaping an object. FMR movies are also useful when demonstrating visual cues, such as the change in the shape of the pointer when it moves over certain objects.

A handy cam icon is displayed on slides generated using FMR.

Note: FMR files increase the size of the project.

File Export Types

Captivate projects can be exported in a variety of file formats:

- **SWF** (Small Web Format - great for publishing to the Web). This is the default option.
- **Windows Executable** (EXE file - a simple program file)
- **MAC Executable**
- **F4V Video**
- **F4V with mixed frame rate**

Creating New Projects Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software simulation</td>
<td>Record events in an application or a screen area on your computer screen using Adobe Captivate.</td>
</tr>
<tr>
<td>Blank Project</td>
<td>You can start from a blank project with the selected project dimensions.</td>
</tr>
<tr>
<td>From Microsoft Powerpoint</td>
<td>You can import an entire PowerPoint presentation, or only selected slides, into an Adobe Captivate project.</td>
</tr>
<tr>
<td>Image Slideshow</td>
<td>Import a set of images to create an image slideshow.</td>
</tr>
<tr>
<td>Project Template</td>
<td>When working on similar projects or modules within a larger project, you could create projects from templates. Project templates ensure consistency and improve the efficiency of people working in a collaborative setup.</td>
</tr>
<tr>
<td>From Template</td>
<td>Choose a predefined template for your project.</td>
</tr>
<tr>
<td>Aggregator Project</td>
<td>Combine multiple SWFs into a single project using the Aggregator.</td>
</tr>
</tbody>
</table>
Slide Types

Adobe Captivate allows you to create projects with many different types of slides. You can include some or all of the following slide types in a single project:

- **Blank slides** are useful when you want to create a slide from scratch.
- **Image slides** contain an image in JPG, JPEG, GIF, PNG, BMP, ICO, EMF, or WMF format inserted as a background. You can create an entire project from image slides and use it as an album.
- **Question slides** contain quizzing functionality
- **PowerPoint slides** are slides imported from a PowerPoint presentation.
- **Animation slides** contain an animation in SWF or GIF format.
- **Master slides** that help you define a uniform look and feel for all the above slides.

Captivate Objects

Objects are different elements that you can add to Adobe Captivate slides.

These objects enhance the usability and interactivity of your Adobe Captivate project. **Standard Objects** available in Captivate are:

- Text caption
- Rollover caption
- Rollover image
- Highlight box
- Click box
- Button
- Text entry box
- Rollover Slidelet
- Zoom area
- Mouse

Other tools available are:

- Drawing tools
- Animations
- Animated text
- FLV/F4V
- Widgets
<table>
<thead>
<tr>
<th>Object Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click boxes</td>
<td>Click boxes are areas on the slide where the user must click before the next action can take place</td>
</tr>
<tr>
<td>Rollover captions</td>
<td>Use rollover captions when you want to display the caption (text) only when the user moves the mouse over a designated area on the slide.</td>
</tr>
<tr>
<td>Text entry boxes</td>
<td>Text entry boxes are text fields into which users can enter text. Text entry boxes are a great way to test users’ knowledge.</td>
</tr>
<tr>
<td>Buttons</td>
<td>You can increase the interactivity of your Adobe Captivate projects by adding buttons - e.g. to move between pages</td>
</tr>
<tr>
<td>Widgets</td>
<td>Widgets can help provide enhanced interactivity and rich content rapidly. There are many different types of widgets.</td>
</tr>
<tr>
<td>Text captions</td>
<td>You can use text captions to draw attention to specific areas of the slide and add text to a slide</td>
</tr>
<tr>
<td>Highlight boxes</td>
<td>Highlight boxes focus the user’s attention on the required areas of the slide. Use highlight boxes to spotlight areas within a slide.</td>
</tr>
<tr>
<td>Mouse</td>
<td>Customise the look and behaviour of the mouse pointer in the Captivate project</td>
</tr>
<tr>
<td>Rollover slidelets</td>
<td>A rollover slidelet is a space on a slide that displays an associated slidelet (a slide within a slide) when the mouse is moved over the space.</td>
</tr>
<tr>
<td>Zoom areas</td>
<td>Zoom areas help you draw the learner’s attention to important sections of a slide.</td>
</tr>
<tr>
<td>Images and rollover images</td>
<td>You can incorporate images into projects as logos, startup screens, pointers, backgrounds, buttons, and more. You can add images as JPG, JPEG, GIF, PNG, BMP, ICO, EMF, POT, or WMF.</td>
</tr>
<tr>
<td></td>
<td>Rollover images consist of an image and a rollover area (the “hot” area). Rollover images appear when the end user moves the pointer over the rollover area at run time.</td>
</tr>
<tr>
<td>Drawing tools</td>
<td>You can use the drawing tools in Adobe Captivate to create artwork for your projects.</td>
</tr>
<tr>
<td>Animations</td>
<td>Animations Adobe Captivate lets you add animation to Adobe Captivate SWF files. This introduces an element of motion that is effective and eye-catching for users.</td>
</tr>
<tr>
<td>Animated text</td>
<td>Animated text is text that has applied special effects.</td>
</tr>
<tr>
<td>FLV/F4V</td>
<td>You can add FLV/F4V files to make your projects more interesting.</td>
</tr>
</tbody>
</table>
The Object Toolbar and Control Panel

The Object Toolbar:
- Selection Tool
- Insert Text Caption
- Insert Rollover Caption
- Insert Highlight Box
- Insert Click Box
- Insert Button
- Insert Text Entry Box
- Insert Rollover Slidelet
- Insert Zoom Area
- Insert Mouse
- Insert Text Animation
- Draw Shapes
- Set Stroke Colour
- Set Fill Colour
- Set Stroke/Fill to Black/White
- Swap Fill/Stroke Colours

The Control Panel:
- Open
- Save
- Copy
- Duplicate
- Undo/Redo
- Cut
- Paste
- Delete

Application Bar (selected options only):
- Record Audio
- Collaborate
- Send Behind
- Send Backward
- Snap to Grid

- Next/Previous
- Slide Numbers
- Preview Options
- Publish
- Zoom
Notes:

1. The default workspace view is Classic. Change this to Review for more options on the timeline.
2. The timeline is used to change the length of time a slide and other objects are displayed when the movie is played.
3. All objects on the slide are shown in the timeline.
4. To Preview your project, use the Preview button on the menu bar.
5. To Publish the finished movie, click on the Publish button in the menu bar.
6. To delete a slide, click on the slide in the filmstrip and press the delete key on the keyboard OR right click on the slide in the filmstrip and select delete.
7. You may import slides created in PowerPoint or Photoshop.
Recording a Software Simulation

1. Open the software program you wish to use in the recording.
2. Open Captivate
3. The software opens with the welcome screen showing in the workspace window.
4. Under Create New, select Software Simulation
5. Set the required settings
6. **Screen Area:**
   a. Select the window of the software program to use for the recording from the drop down menu
   b. Set the Capture Area of the window to be captured to **Custom Size**
   c. The default area is 640 pixels x 480 pixels (suitable for most computer monitors)
   d. Select: **Automatic** for Recording Type
   e. Select **Demo** for a simple demonstration
   f. Use the default for Panning and Audio
   g. Audio can be recorded at a later stage

OR

7. **Application:**
   a. Select the software window to select using the drop down menu
   b. Set to **Automatic** recording
   c. Select **Demo** for a simple demonstration.
   d. Use the default for Panning and Audio
   e. Audio can be recorded at a later stage

8. **Note:** You can choose to record in more than one mode e.g. Demo, Assessment, Training. One file will be created for each mode and displayed on different tabs in the Captivate workspace.
9. Click the **red record button** to start recording your actions.
10. Each time the mouse is clicked you will hear a camera shutter sound - this indicates that a picture of the screen has been taken.

11. To insert extra screen shots press the **Print Screen** key on the keyboard.

12. To **end the recording**, press the **End** key on the keyboard. Make sure you know where this is located on the DER netbooks.

13. All screen shots taken by Captivate will be collated and shown in the Captivate workspace and Filmstrip.

14. The slides can be edited as required - you may delete slides, record additional slides to the project, add narration, add titles etc.

15. The **timeline** shows the slide and all content/objects on that slide.
16. Use the Timeline to:
   a. Lengthen or shorten the length of a slide by clicking on the red line at the end of the slide and dragging it to the right (to lengthen the slide) or to the left (to shorten the slide)
   b. Dragging the red line along the timeline plays the slide.
   c. By default, all slides will be displayed for 3 seconds. (This can be changed using Edit...Preferences...Defaults and setting the slide duration as required)
   d. Move the captions inserted by Captivate to a new position if required.

17. You may add additional captions to your project:
   a. Click on the slide you want to insert a new text caption
   b. Click on the Insert Text Caption icon in the toolbar
   c. A new text caption is added to the slide in the workspace window
   d. Double click in the box to edit the text.
   e. Make sure you have clicked back onto the selection tool in the toolbar to allow the text caption to be moved and to be edited.
   f. The Properties panel can be used to edit the text caption as required.
   g. Note: You may need to collapse the different properties to see the full list of options available.
   h. You may:
      i. Change the name of the text caption
      ii. Change the type of caption type using the drop down menu in the General option.
      iii. Click on Caption Widgets for more styles.
Change the font, style, colour and size used for the text using the **Character option**

v. Change the **Timing** - how long the text caption is displayed

vi. Change the **Transition** - how the text caption appears/leaves the slide

vii. Add **Audio** to the caption.

viii. Change the **Size** of the text caption.

### Using Audio in Adobe Captivate

You can add audio to your project by:

i. **Narrating** the movie into a microphone as you record the project or after it has been recorded.

ii. **Importing audio files** into the movie after you complete recording it. You can import saved audio files saved on a computer/USB etc. or you can import from the **Library** included in Captivate (there are sound effects available).

iii. **Converting slide notes to speech** using the **Text to Speech** option.

You can add audio to any of the following in Adobe Captivate:

i. Slides

ii. Project

iii. Objects

The audio file plays when the slide, project, or object appears in the movie.

### Using the Text-to-Speech Converter

Captivate lets you convert text to speech on slides. To convert text to speech we need to have the **Slide Notes** panel available in the Timeline.

i. From the **Windows** menu select **Slide Notes**

ii. The **Slide Notes tab** is added to the **Timeline**.

iii. In the filmstrip, click on the slide you want to add speech to.

iv. With the **Slide Notes tab** selected, click **Text-to-Speech**
v. Click on the plus sign.

vi. Enter the text to be spoken in the highlighted *Enter TTA text*

vii. Click *Generate Audio*

viii. Click *Save*

ix. You may add more text to be converted to speech by clicking on the plus sign (+). Don’t forget to click *Generate Audio* when changes are made.

x. The text is merged into one audio file to be played when the movie is played.

xi. The audio file will be visible on the *Timeline* for that slide.

xii. **Note**: When you edit a slide note, you must click *Generate Audio* again for the changes to be applied.

xiii. To *delete* the generated audio from the slide right-click on the *speaker icon* on the slide in the *Filmstrip* and click *Remove*.

**OR**

In the *Slide Notes window*, click in the row (with the tick box) containing the question and click the *subtract* symbol to remove the audio.
Recording Audio

To record audio onto a single slide:

i. Plug in your microphone or use an in-built microphone if using a DER netbook

ii. Click on the slide you want to add audio to

iii. Click on the Record Audio icon in the Control Panel

iv. The Slide Audio dialog box is displayed.

v. Click on the red button to begin recording

vi. It will countdown from 3 before it starts recording

vii. Record your narration

viii. When finished click the Stop icon

ix. Click Save

x. The audio will be displayed in the Timeline

xi. **Note:**

    a. For slides with unique audio files, the **Timeline of the slide is stretched to match that of the audio file.** However, audio files for a project are cut short if they exceed the project Timeline.
Importing Audio onto a slide

To import an audio file onto a single slide:

i. Click on the required slide
ii. Click on the Record Audio icon in the Control Panel
iii. The Slide Audio dialog box is displayed.
iv. Click on Import
v. The Import Audio dialog box is displayed.
vi. A list of sound effects from Captivate is displayed.
vii. Navigate to the location of your saved audio file
viii. Click on the name of the audio file
ix. Click Open
x. Click Save
xi. The slide duration will be changed to match the length of the audio file unless you say no when prompted.
xii. The audio file is inserted into the timeline of the selected slide.
Using the Audio menu item

The Audio menu item is used if audio is to be imported or recorded on multiple slides or into the background of a project.

The Audio menu item can be used to import audio to an object, slide or background. The object must be selected before the option is available in the menu:

**Import to:**

i. Object
ii. Slide
iii. Background

The Audio menu item can be used to record audio to an object, slide, slides, background. The object must be selected before the option is available in the menu:

**Record to:**

i. Object
ii. Slide
iii. Slides
iv. Background

Importing audio as background music

To add background music to the whole project:

i. From the Audio menu select *Import to...Background*
ii. The following message is displayed. Select *Yes*

iii. From the *Import Audio* dialog box select the required background music and click *Open*
iv. The music is added to the background of the project, that is, all slides.

v. **Note:** The music will stop when the project ends
Adding a Title Slide

To add a title slide to your project:

i. Click on Slide 1
ii. From the Insert menu select Blank Slide
iii. Click on the Insert Text Caption in the toolbar.
iv. Edit the text in the text caption.
v. This text caption must be made a **Transparent** caption.

vi. In the properties panel click on the **General** option.

vii. **Caption Type:** select **Transparent** from the drop down menu.

viii. Use **Character:** to choose a font, text colour and size for the heading.

ix. To change the **background colour** of the slide:
   
   a. Click on the slide background.
   
   b. The **General** option is activated.
   
   c. De-select (un-tick) the **Project Background** box.
   
   d. Click on the **Stage** box and choose a colour from the colour palette displayed.

x. You may also use an **image** as a background.

   a. Click on the **Folder** icon in the **General** option in the Properties panel.
b. From the Select Image from Library dialog box displayed click on Import

c. Navigate to the location of your image.

d. Click on the name of the image and click Open.

e. You may re-size/crop and/or edit the image as required.

f. Click OK
g. The image will be inserted onto the slide as a background that cannot be moved.

h. Click on the Pencil in the General options to re-edit the image.
Inserting Animated Text

Captivate lets you insert animated text for your heading.

i. Click on the Insert Text Animation icon in the Toolbar.
ii. In the Text Animation Properties dialog box type in the text to be used.
iii. Select the Font, Size, Colour as required.
iv. In the Properties panel, click on the down arrow next to Effect and choose an animation effect.
v. The chosen animation will be previewed in the window.
vi. Note: The animation will play when the project is previewed.
Inserting an Image Slide

An image slide is a slide that has an image as the background. Once the image slide has been created you cannot alter the image in any way.

To create an image slide:

- From the Insert menu select Image Slide
- Select the image from the location it is saved at.
- Click Open
- Make changes to the image as required in the Resize/Crop window
- Click OK
- The image slide is added to your project.

Insert an image

- Click Insert...Image
- Navigate to the folder containing the image, click on the image, click OK
- The image is added to the slide
- Click Fit to Stage in the Properties panel to resize the image to fit the whole slide OR re-size as required
- **Note:** To make the slide an image slide, right click on the image and select Merge with background from the short cut menu.
Creating interactive quizzes

A variety of interactive questions can be created in Captivate to create an interactive quiz. You can add a quiz slide to an existing project or create a new project with only question slides.

Create a new blank project:

i. From the **File** menu select **New Project...Blank Project**

![Image of File menu showing the option to select New Project...Blank Project](image1.png)

ii. Set the size of the project screen as required.

iii. Full screen 600 x 800 is a good size if not sure of measurements.

iv. Accept the default if unsure.

v. Click **OK**

vi. From the **Insert** menu select **Question Slide**

![Image of New Blank Project dialog box](image2.png)
vii. A list of question types is displayed.

viii. You are able to create the following question types:

   a. Multiple Choice
   b. True/False
   c. Fill-in-the-Blank
   d. Short Answer
   e. Matching
   f. Hot Spot
   g. Sequence
   h. Rating Scale
Setting Quiz Preferences

i. Select **Quiz...Quiz Preferences** to set preferences for the quiz.

ii. **Reporting:**
   a. You may export the quizzes into a Learning Management System such as Moodle.

iii. **Settings:**
   a. You can have all questions in the quiz shuffled

iv. **Pass or Fail:**
   a. Change the pass rate from 80% to your requirements

v. **Default Labels:**
   a. Change the labels (prompts) displayed during the quiz e.g. Correct - Click anywhere or press 'y' to continue.

![Preferences settings](image)
Multiple Choice Questions

1. Click in the box next to **Multiple Choice** question type

2. **Type in the number of questions** required of this type and clicked **Graded** question if you want it marked.

3. Click **OK**

4. The slides will be added to the workspace and to the filmstrip.

5. To edit the number of responses for the question, click on **Quiz Properties** in the **Properties panel**

6. In the **General** options, click next to **Answers:** and enter the number of answers for the question.

7. Next to **Points:** enter the point score for the question

8. Tick on the **Multiple Answers box if there is more than one correct answer.**

9. Tick **Shuffle Answers** so the answers are in a different order when the quiz is re-played.

10. You may also set a **Time Limit** for the question if required.

11. Click on the title of the slide and type in Question 1 or other text as required.

12. Click on the text on the slide and enter the question and answers.

13. Use the **Properties panel to set the font, text colour, size etc. as required**

14. **Important!** When all the answers have been entered make sure to click on the **correct answer.** Captivate will use this answer to check the submitted answers.

15. The **Review Area** is the area used to display to users messages such as Congratulations you passed

16. You may edit the text for the text captions **Correct, Incorrect as you wish.**
Hot Spots

1. Insert a new Question Slide
2. Choose Hot Spot
3. This type of question lets you insert an image and ask the student to locate a place on the image e.g. click on the capital of Australia, or asks the student to select the correct answers from a group of images etc.
4. Insert an image on the question slide:
   a. Select Insert...Image
5. Position the blue square over the ‘hot spot’
6. This is the area the student needs to click on to get the question marked correct.
7. In the Properties panel, click Quiz Properties
8. Change the mark value of the question as required.
9. Click Browse next to Default Animation to select a different style for the hot spot symbol.
10. Tick the box ‘Allow clicks only on Hotspots’ to avoid the students clicking numerous times.
11. Note: You may also allow the user to have more than one attempt at answering the question. Next to Attempts: click and enter the number of attempts allowed.
True or False Quizzes

To insert another quiz slide:

- Click **Quiz...Question slide** from the main menu.
- Type in a title for the slide instead of True/False e.g. Question 1
- Type in the statement/question
- Indicate the correct answer by clicking on the radio button next to the answer True or False.
- You can also change the words True and False in the answers section of the settings panel to any statement by double clicking on the word True or the word False.
- Use the **Quiz Properties panel** to make changes as required, for example:
  - Points value
  - Time Limit
  - Attempts
- Click **OK** to submit your settings.
- **Note:** Unlike Multiple Choice, this question cannot be shuffled but it can be placed randomly in the whole quiz so that students may or may not see it.
Fill in the blank

To insert another quiz slide:

- Click Quiz…Question Slide
- Select Fill in the Blank.
- Name the slide
- You can change the instruction given to students
- Type the phrase to be used in the question to replace the text below.

Type the blank phrase

- To remove specific words highlight the word in the phrase and click Mark Blank from the Quiz Properties panel.
- The word that will not be displayed in the quiz will be underlined.
- If there is more than one possible answer, you can add words that will be accepted:
  - Double click on the word to be filled in by the student
  - Click the Add button
  - Type in the alternative word

The capital of Australia is Canberra.

- Captivate will compare EXACTLY any response the student makes to this list of words. It is best NOT to have Case Sensitive selected.
- If they come up with a related word that is NOT in your sanctioned list, Captivate will mark their response as incorrect.
- To unmark a word, double click on the word and select Unmark Blank from the Quiz Properties panel.
Short answer

To insert another quiz slide:

- Click Quiz...Question Slide
- Select Short Answer.
- Name the slide
- You can add more instructions to students by using captions.
- Type the question replacing the text:

**Type the question here**

- Type in the acceptable answers in the acceptable answers in the Correct Entries box
- Click the plus sign + to add more than one acceptable answer

**Note**: Short Answer quizzes need to be very **specific in the terminology** you teach before taking the quiz. Captivate will compare the student’s response **EXACTLY** against your acceptable answers. Any variation in spelling, grammar or terminology will be marked incorrect.
- If you want the student’s response to be case sensitive as in the usage of nouns, tick the check box next to the answer is case-sensitive.
- Use the Quiz Properties panel to set properties as required e.g. points value, time limit.
Matching

- Click Quiz...Question Slide
- Select Matching
- Name the slide
- Type in some instructions for the students
- Give Column 1 a title (double click on Column 1 and type in a name)
- Give Column 2 a title (double click on Column 2 and type in a name)
- Double click on the text in column 1: type the item here
- Type in the question data
- Repeat for each item of data
- Double click on the text in Column 2: A) type the answer here
- Type in the answers
- Select the correct answers for each data item in Column 1 using the drop down box - this will match each item with the correct answer. Captivate will show the correct matches using lines.
- Note: The correct answer DOES NOT need to be next to the item.
- When played, students can choose each correct answer using the drop down box OR a student can drag and drop the answer next to the question.
- Use the Quiz Properties panel to set properties as required: e.g. Points, Time Limit, Shuffle Column 1, Column 1 and Column 2 number of items.
Sequence quizzes are a great way to build in a numeracy aspect to a Captivate quiz.

- Click **Quiz…Question Slide**
- Select **Sequence**
- Name the slide
- Type in some instructions for the students
- Double click on the text and type in the required text
  
  type the answer here

- Use the Quiz Properties panel to determine the number of **Answers** in the list.

- When entering a **sequence** it must be entered in **order**. Captivate will automatically randomise the order when the slide is played.

- Set other properties in the **Quiz Properties panel** as required.

---

**Sequence**

Arrange the days of the week from the first working business working day to the last day of the weekend.

A) Monday  
B) Tuesday  
C) Wednesday  
D) Thursday  
E) Friday  
F) Saturday  
G) Sunday

---

**Arrange in sequence**

A) type the answer here  
B) type the answer here
Rating scale (Likert)

A Rating Scale or Likert Scale is a method of asking your student’s opinion and therefore no grading is available.

- Click Quiz…Question Slide
- Select Rating Scale (Likert Scale)
- Name the slide
- Type in some instructions for the students
- Double click on the type the item here and type in your statement
- From the Quiz Properties panel, set the number of Answers
- Double click on the titles and edit if you want to change the categories Disagree, Somewhat disagree etc.
- The best thing about the rating scale is the ability to hold multiple questions on the same slide.
- If you want to split rating questions across several slides create a new quiz slide for each question/statement to be rated.
Using the Question Pool Option

A question pool is an Adobe Captivate feature that stores a collection of quiz questions. After you create a question pool, you can create new projects that include random question slides. Random question slides randomly select and display questions from the question pool you specify. These slides help avoid quiz predictability.

1. Click on the Quiz menu and select
2. The Question Pool Manager dialog box is displayed:

3. Click the plus symbol above the left pane to add a question pool.
4. Give the pool a name (pool names cannot include spaces).
5. With the question pool selected, click the plus symbol above the right pane to add a question.
6. The Insert Questions dialog box appears.
7. Select a question type and the number of these question types needed and select Graded or Survey from the pop-up menu.
8. Click OK.
9. The new question is added to the Question Pool Manager dialog box and to the Question Pool panel at the bottom of the window.
10. When you finish creating the questions in the pool, click Close to close the Question Pools Manager.
   a. Note: This only adds the type of question you want to add, not the actual content of the question.
11. You can add more questions to the pool by reopening the Question Pool Manager from the Quiz menu.

So far, the questions you’ve added to the pool include placeholder question and answer text.

The next step is to **modify each question**.

1. In the **Question Pool panel** (below), select a question to modify and replace the placeholder question and answer text with actual content.
2. Use the **Quiz Properties** panel to adjust the properties for each question.

![Question Pool Panel](image)

3. You will need to **import the question pool** into your quiz project to use the questions.

**Importing quiz questions from a question pool**

1. Open the Adobe Captivate project to which you want to add quiz questions from the pool.
2. Click **Window** and make sure that **Question Pool** is selected.
3. The Question Pool panel is open at the bottom of the window.
4. Click **File**, click **Import**, and then click **Question Pools**.
5. Locate the project that contains the question pool; click the **project to import**, and click **Open**.
6. The **Import Question Pools** dialog box appears.
7. Select the check box of the pool and questions you want to import and click **OK**.
8. The questions you imported are added to the Question Pool panel.
9. To move questions into a project, **right click** on the question in the pool and select **Move Question to > Main Project**.
10. You can also add **random quiz questions** that will pull from this pool of questions.
Inserting Rollover Captions

Use rollover captions when you want to display the caption only when the user moves the mouse over a designated area on the slide. Rollover captions consist of a caption and a rectangle that marks the designated area, also called the rollover area. The caption appears when the user moves the mouse over the rollover area when the slide is played.

This is useful when creating resources where you want students to learn about the different parts of an image e.g. the parts of an eye.

To insert a rollover caption:

i. Insert an image onto the slide. Select Insert...Image

ii. Click on the Insert Rollover Caption icon in the toolbar

iii. A text caption and blue rectangle is added to the workspace.

iv. Click on the text caption and edit the text and position as required.

v. Click on the blue rectangle (rollover area), re-size and move the rectangle to the required area. The text caption will be displayed when the mouse is hovered over the designated rollover area.

vi. Use the Properties panel, Fill and Stroke option to reduce the stroke to 0 so there is no outline visible on the rollover area.
Inserting a Rollover Image

Rollover images consist of an image and a rollover area (the “hot” area). Rollover images appear when the end user moves the pointer over the rollover area during the animation. They are useful for heavily detailed slides or for slides that contain buttons or toolbars that require explanation.

To add a rollover image:

- Select the slide to which you want to add a rollover image.
  - **Note**: This slide should already have an image or diagram on it
- Select Insert...Standard Objects...Rollover Image.
- Select an image from the list or browse to a new location for a different image.
- Click Open.
- Re-size the image as required and use the Properties panel to make changes if required.
- The rollover area is also added. Drag the image to the desired location and adjust the rollover area as needed.
- Set Properties and options as required.
  - Set the Width to 0 so the rollover rectangle has no border
- Click OK.
- When played, once the mouse is rolled over the rollover area the rollover image is displayed.
Adding Buttons to slides

You can increase the interactivity of your Adobe Captivate projects by adding buttons. You determine what happens after the user clicks the button.

To add a button:

Note: Resize any buttons before resizing the project. Resizing a project does not resize the buttons automatically.

- Open the slide to which you want to add a button.
- Select Insert...Standard Objects...Button.

OR

- Click on the Insert Button on the Object toolbar
- Note: You can delete a button at any time by selecting it and pressing the Delete key. When you delete a button, all associated objects (such as success and failure captions) are also deleted.
- The button appears on the slide.
- Size and drag the button as desired.
- Double-click the Success, Failure, or Hint captions to edit the text.
- OR delete the Success, Failure, or Hint captions if not needed.
- To change the properties of the button, click the button and change the properties in the Property inspector.
- Examples of buttons you can add include Home, Next etc.
- You can also import custom button images you have created.

![Button Example](image)
Inserting a Text Entry Box

Text entry boxes are text fields into which users can enter text by typing from the keyboard. Text entry boxes are a great way to test a users’ knowledge. After the user answers a question, Adobe Captivate matches the answer with the answers that you have set when creating the text entry box. You can even provide a hint to the user if you want to.

To add a text entry box to a slide:

1. Open the slide to which you want to add a text entry box.
2. Select Insert...Standard Objects...Text Entry Box. The text entry box appears on the slide.

OR

3. Select the Insert Text Entry Box tool from the Object Toolbar.
4. Size and drag the text entry box as desired.
5. Double-click the Success, Failure, or Hint captions to edit the text. Type in the text you want displayed as feedback when the user’s text is checked against the text entered.
6. To change the properties of the text entry box, click the box and change the properties in the Property inspector.
7. You will also need to add a Text Caption to your slide so the user knows what needs to be entered into the text entry box.
8. Make sure you set the caption to Transparent to avoid having the caption in an outlined text box.
9. You may use Text Animation if you want a fancier text effect.
Inserting a Rollover Slidelet

A **rollover slidelet** is a space on a slide that displays an associated slidelet (a slide within a slide) when the mouse is moved over the space. You can **insert and display objects in the slidelet** using the same procedure as that for other slides.

- You can insert most of the Adobe Captivate objects into a slidelet, e.g. images, audio
- You can place more than one type of object into a slidelet. The objects become visible when the mouse is moved over the rollover slidelet.
- You can drag audio and movie files from the Library into a slidelet.

To insert a rollover slidelet:

- **Select Insert…Standard Objects…Rollover Slidelet.**
- Two spaces will be inserted onto the slide:
  - **Rollover slidelet** (this is used to designate the rollover area that will trigger the contents of the slidelet to be displayed.)
  - **Slidelet** (this is the slide that you can insert an image or audio into)
- **Position the rollover slidelet** as required e.g. on an image
- **Re-size** as required
- Use the **Properties panel** to make changes as required.
- Select the **slidelet** by clicking it
- Select **Insert** and choose the object that you want to insert e.g. image, audio
- Click **OK**
- In the **Properties Panel** set the options for the rollover slidelet as required.
- **Note:** Whenever a new rollover slidelet is inserted, the default timing is Rest Of Slide. If required, you can modify the properties later.
- **Note:** You cannot insert a rollover slidelet, mouse, text entry box, click box, or button within a slidelet.
Using Advanced Actions

Advanced Actions are useful if you want to **execute multiple actions** (perhaps as a result of a user clicking a button), or if you need to execute one or more actions based on conditions.

When you create Advanced Actions using the script editor, you are effectively writing a simple program. But you don’t have to remember any programming commands or syntax — it’s all point and click.

To create advanced actions:

- Select **Project…Advanced Actions**.
- Select the action type:
  - **Standard Action**: To customize one of the predefined actions in Adobe Captivate. For example, display more than one text box when the mouse is clicked.
- In the **Action Name**, specify a name for the action.
- Click the **add icon**.
- Use the **drop down menu to choose** an Action e.g. Show.
• Use the drop down menu in the 2nd column to select an item you want to use, e.g. Text_Caption_6
  o **Note:** It is best to give the item a meaningful name so it is easier to identify and use. E.g. name the planets of the solar system Earth, Mars etc.
• **One** item per row.

- Repeat this process adding an action and an item in each row.
- The **square** in the first column should be **Green** to indicate the script is correct. Any option that has not been assigned a value is indicated by the **red** square. If you do not set these values, it results in an error when you try to save the script.
- **Click Save** to save the script.
To apply the advanced actions to interactive objects such as a button:

- Click on the button or interactive object
- In the Property Inspector go to Action.
- In the Action menu, On Success: select Execute Advanced Actions.
- In Script, click the down arrow and select the script that you created and that you want to apply to the object.

This is an interactive button. When this is clicked the names of the planets are displayed on the diagram.

Names of planets are text captions.

Text captions must be set to invisible in the properties panel when they are created so they don’t appear until the button is clicked.
Using Variables

Variables in Captivate act as placeholders for data. Adobe Captivate offers two types of variables:

1. System variables (e.g. date, time etc.)
2. User defined variables (created by the user)

User defined variables can be created and used to collect, store and display information such as a person’s name, school, year group etc. Using user defined variables adds greater interactivity to the project.

There are three steps involved:

1. Create and name the variable (e.g. name, school)
2. Create a text input box for the user to enter text.
3. Assign the text box to the variable created.

Step 1:

1. From the Project menu select Variables
2. Select user from the drop down menu
3. Click Add New
4. Type in a Name for the variable e.g. v_name
5. Click Save
6. Click Close
7. Click on the first slide - or the slide you want the user to input their name
8. Click on the Insert Text Entry Box icon in the toolbar
9. In the Properties panel in General - Default Text: type in the text to be displayed in the text entry box (a message for the user)
   OR
10. Leave this text entry box blank.
   o Note: If you leave it blank, insert a Text Caption (transparent) above the Insert Text Entry box to give the user an instruction, e.g. enter your name, enter your school name.
11. Important! Un-tick the box: Validate User Input
12. Use the Properties panel - Character to change the font, text size, text colour etc.
13. In General next to Var Associate click on the down arrow and select the variable created i.e. v_name
   - This assigns the variable created to the text input box, that is, whatever is typed into the text input box will be used whenever the v_name variable is used in the project.

Step 2:

1. Click on the slide you want to use the input data
2. Insert a transparent text caption and type in the required text e.g. Welcome
3. Leave a space in the text caption
4. From the Properties panel, Format option, next to Insert click the insert variable icon
5. From the **Insert Variable** dialog box use the down arrow next to **Variable:** to select the **created variable v_name**.

6. Click **OK**

7. The place holder is inserted for the input data - dollar symbols enclose the variable name.

```
Welcome $$v\_name$$
```

8. Preview your project.

9. Where ever the variable v_name is used, it will be substituted with what the user inputs into the text input box.
Publishing a project

The last step is to publish your project. An Adobe Captivate project can be published in several formats:

- As a Flash (SWF) file (this option includes saving the file in HTML format and PDF format)
- To an Adobe Acrobat Connect Pro Server (not suitable)
- As Media (as an executable file - .exe)
- As an e-mail attachment
- FTP to the web
- Print

The most common format is to publish the project as a Flash (SWF) file. Always tick Export to HTML and Export PDF - this is useful if the user’s computer doesn’t have the latest version of Flash available.

Make sure you:

- Name your project in the Project Title box
- Select Flash (SWF) - the first and default option
- Browse to select the location in which to save the published file.
- Click Export to HTML
- Click Export PDF
- Click Publish

The published file will launch using Flash player.
Publishing SCORM compliant projects

SCORM (Shareable Content Object Reference Model) is the reporting system which can connect Captivate with Learning Management Systems such as Blackboard and Moodle.

To publish your project as a SCORM compatible project:

- Click on Quiz…Quiz preferences from the main menu.
- Click Reporting
- Click on Enable reporting for this project at the top of the dialogue box.
- Make sure that the LMS is set to Standard and SCORM.
- Set Report to LMS to Score
- Set Reporting Level to Interactions and Score
- Click OK to confirm the settings.
- Click on Publish from the main menu. In the new dialogue box it is important to click zip files as you need to give all the files related to your project to your system administrator. It is easier to fit all the files on a CD or USB if they have been zipped.
- It is also easier to collect the files for your system administrator if you direct the files related to your project to a location that is easy to find.